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Chapter 1 About DragonDictate

Welcome to DragonDictate® TalkÔTo  PerfectOffice  and the

DragonDictate for Windows Starter Edition, speech-recognition

products that let you run commands simply by speaking into a

microphone. This guide tells you how to use both products.

DragonDictate TalkÔTo PerfectOffice lets you control Microsoft®

Windows  by speech. Besides letting you control Windows by

speech, the DragonDictate for Windows Starter Edition lets you

dictate text into your applications.

DragonDictate TalkÔTo PerfectOffice
DragonDictate TalkÔTo lets you use speech commands to navigate in

Windows and work with Windows applications, like WordPerfect® for

Windows.  (Speech commands are words or phrases you say to start

or carry out actions.)

Instead of using your mouse or keyboard, use speech to 

n start an application

n open a document

n move within a document

n cut, paste, and copy text in a document

n work with menus and dialog boxes

n save and print a document

DragonDictate TalkÔTo comes with vocabularies. Vocabularies are

collections of speech commands for Windows tools (like File

Manager), Windows accessories (like Calculator), or Windows

applications (like WordPerfect for Windows). For example, the

WordPerfect 6.1 vocabulary contains all the speech commands you

can say when working with WordPerfect 6.1 for Windows.
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What Chapters of This Book Apply to You
If you have DragonDictate TalkÔTo PerfectOffice, all the chapters

of this book apply to you except for Chapter 4, ‘‘Dictating Text.’’

You need the DragonDictate for Windows Starter Edition to dictate

text. Contact WordPerfect for more information about purchasing it.

Note Refer to your WordPerfect documentation for the
WordPerfect phone number and the Starter Edition 
order number.

DragonDictate for Windows Starter Edition
The Starter Edition works exactly like TalkÔTo, but adds dictation

features. Besides letting you run commands, the Starter Edition also

lets you dictate text in your favorite Windows applications, like

WordPerfect and Borland® Quattro® Pro for Windows.

If you’re a lawyer who dictates legal data, a doctor who enters

patient records into a database, or a business professional who finds

typing difficult, the DragonDictate Starter Edition makes it easier to

get your work done.

The Starter Edition comes with a dictation vocabulary of 5,000

words, letting you do all your work in Windows by speech.

Note Contact WordPerfect for more information on purchasing
the Starter Edition. Chapter 2 of the DragonDictate
Getting Started Guide tells you how to install it. Chapter
3 of the DragonDictate Getting Started Guide tells you
how to upgrade to the Starter Edition if you have already
installed TalkÔTo.

What Chapters of This Book Apply to You
If you have the DragonDictate for Windows Starter Edition, all the

chapters of this book apply to you. In particular, refer to Chapter 4,

‘‘Dictating Text.’’

DragonDictate User’s Guide
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Supported Applications in Standard Office
DragonDictate TalkÔTo PerfectOffice and the DragonDictate for

Windows Starter Edition work with most Windows applications.

You can use DragonDictate with any WordPerfect for Windows

product, including the following applications that come with

WordPerfect Standard Office:

n WordPerfect® 6.1 for Windows,  a word processor

n WordPerfect Presentations  3.0 for Windows, a presentation

graphics package

n Borland® Quattro® Pro 6.0 for Windows, a spreadsheet program

n WordPerfect InfoCentral  1.1, a personal information manager

n WordPerfect Envoy  1.0a, an online viewer

n Novell® GroupWise  4.1 QuickLook, an electronic mail

package

Supported Applications in Professional
Office
DragonDictate TalkÔTo PerfectOffice and the DragonDictate for

Windows Starter Edition work with most Windows applications.

WordPerfect Professional Office includes all the applications that

come with WordPerfect Standard Office. DragonDictate supports

the following additional applications that come with WordPerfect

Professional Office:

n Borland Paradox® 5.0 for Windows, a database program

n Visual AppBuilder  1.0, a development tool

Chapter 1: About DragonDictate
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Who Should Read This Manual
Dragon Systems assumes you’re already familiar with DOS and

Microsoft Windows. If you need help using Windows, refer to the

Microsoft Windows User’s Guide.

Dragon Systems strongly recommends that you first refer to the

DragonDictate Getting Started Guide, which describes installing

DragonDictate TalkÔTo PerfectOffice or the DragonDictate for

Windows Starter Edition, running the online Tutorial, and running

Quick Training.

Then do the lessons in Chapter 2 of this manual. It’s the ideal way to

begin learning DragonDictate.

Document Conventions
While you can speak to DragonDictate to do any task, completely

hands-free use of DragonDictate is optional: you may prefer to use

your keyboard or mouse. For that reason, most procedures in this

book show you how to perform a task by speaking, or by mouse and

keyboard.

Following are the typographical conventions you’ll find in this guide:

When you see It means

  @   Say Move Up Say the words ‘‘move up’’ without pausing

between words.

  @   Say Bring Up, then say 

Notepad

Say the words ‘‘bring up’’ without pausing

between words, then say the word

"Notepad."

� Click OK Use the mouse to click the OK button.

� Press Ctrl+Esc Simultaneously press the Control and

Escape keys.

� Type C:\ Type the characters ‘‘C:\’’.

icon name Replace icon name with the name that

appears on the icon label.

Move left n Replace n with a numeric value.

DragonDictate User’s Guide
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Chapter 2 Working with DragonDictate

With DragonDictate installed, it’s time to learn more about it. This

chapter has lessons that you can go through at your own pace.

The lessons in this chapter, particularly Lesson 3, are written for

DragonDictate TalkÔTo PerfectOffice. Refer to chapter 4 if you

have the DragonDictate Starter Edition, which lets you dictate text

in Windows applications.

Note Dragon recommends that you run Quick Training. It
improves speech recognition, making DragonDictate easier
to use. Refer to ‘‘Running Quick Training’’ in chapter 2 of
the Getting Started Guide or chapter 3 of this online
User’s Guide.

What’s in This Chapter
The following lessons help you to get up and running with

DragonDictate.

n Lesson 1 (Optional): Starting DragonDictate

n Lesson 2: Working with the VoiceBar

n Lesson 3: Running WordPerfect for Windows by Speech

n Lesson 4: Saving User Files

n Lesson 5 (Optional): Exiting DragonDictate by Speech
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Lesson 1 (Optional): Starting DragonDictate
Follow the steps below to start DragonDictate.

Note You can’t start DragonDictate by speech. If you want
DragonDictate to start up automatically when you start
Windows, refer to Chapter 7, ‘‘Fine-Tuning
DragonDictate,’’ in this User’s Guide.

1 Start Windows.

2 � Double-click the DragonDictate icon in the DragonDictate for

Windows Program Group.

Wait a few moments for the program to start up. Then the VoiceBar

appears. That’s all there is to it!

Note Make sure you’re the current user if more than one person
uses DragonDictate on your computer. For details, refer
to Chapter 8, ‘‘Working with Users,’’ in this User’s Guide.

�
This lesson takes less
than 5 minutes to
complete.

If you don’t see the
DragonDictate for
Windows program
group, choose
DragonDictate for
Windows from the
Window menu. (If
DragonDictate for
Windows is not on
the menu, choose
More Windows, 
then choose
DragonDictate for
Windows.)

Double-click the
DragonDictate icon.

DragonDictate User’s Guide
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Lesson 2: Working with the VoiceBar
There are four parts to the VoiceBar, DragonDictate’s main window.

n Voice Menu button

n Active group field

n Microphone button

n Last word field

Clicking the Voice Menu button lets you choose menu commands.

Then you can access the different parts of DragonDictate, including

Tools, Options, and Help.

Clicking the Microphone button turns the microphone on and off.

When the microphone is on, the two fields on the VoiceBar display

information.

The active group field shows you the currently active vocabulary or

group. The active vocabulary or group is usually for the current

application you’re using or the current dialog box on the screen. This

active vocabulary or group usually includes commands that

DragonDictate recognizes right now.

�
This lesson takes less
than 10 minutes to
complete.

Voice Menu Button Microphone Button
Click to select  Click to turn the 
options from the  microphone on 
Voice Menu.  and off.

Chapter 2: Working with DragonDictate
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For example, as shown below, the Write vocabulary is currently

active. It contains some commands that DragonDictate will

recognize, including ‘‘Font Bold.’’ Refer to Chapter 6 of this online

User’s Guide for more details about managing vocabularies.

If you speak a word during the current DragonDictate session, the

last word field shows you the last word or phrase that DragonDictate

recognizes, for example, ‘‘Font Bold.’’

Commands
A command is a word or phrase you say that lets you control

Windows and Windows applications. All commands are enclosed in

brackets, [ ]. That’s way [Font Bold] appears in brackets.

For example, when you say ‘‘Font Bold,’’ you tell Write to change all

the following text you type to bold.

You’ll learn more about commands in lesson 3.

Active Group Field Last Word Field
Identifies the active Shows you the last word or 
vocabulary or group -- phrase DragonDicta te 
in this case, Write. heard you say -- in this case, 

‘‘Font Bold.’’

DragonDictate User’s Guide
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Turning the Microphone On and Off
The VoiceBar should be up and running. Refer to Lesson 1 in this

chapter if you need to start DragonDictate.

1 If the microphone isn’t on

� Click the microphone button.

� Or press the +  key on the numeric keypad.

2 To turn off the microphone, repeat step 1.

While the microphone is on, DragonDictate is listening for your

speech.

Click this button to 
turn the microphone 
on or off.

The microphone icon changes color 
(to light blue, on a color monitor) when 
you turn it on. Also, the button is pressed 
in when you turn on the microphone.

You can a lso tell the microphone is on 
by viewing the volume meter, which 
flickers as DragonDictate recognizes 
speech or picks up noise.

Chapter 2: Working with DragonDictate
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When to Turn the Microphone Off

Turning the microphone off lets you keep DragonDictate running

while you use the mouse or keyboard to work in Windows. You may

also want to turn off the microphone if you want to keep

DragonDictate running while you go to a meeting, when someone

walks into your office, or while you talk on the phone.

Turn on the microphone when you’re ready to speak to

DragonDictate again.

Note You can also use the keyboard and mouse while the
microphone is on.

The microphone icon changes color 
(to gray, on a color monitor) when you 
turn it off. Also, the button is pushed out, 
not pressed in, when the microphone is off.

You can also tell the microphone is off 
because the volume meter doesn’t 
register sound.

DragonDictate User’s Guide

10



Lesson 3: Running WordPerfect for
Windows by Speech
In this lesson, you learn the basics about controlling a Windows

application -- in this case, WordPerfect for Windows -- by speech.

n Why correcting mistakes is important

n Correcting errors with the Word History

n Copying the WordPerfect program icon

n Changing the name of the program icon

n Starting WordPerfect

n Opening a document

n Cutting and pasting text

n Saving and printing the document, and exiting WordPerfect

�
This lesson takes
about 30 minutes to
complete.

Chapter 2: Working with DragonDictate
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Why Correcting Mistakes Is Important
When you speak to DragonDictate, DragonDictate does its best to

recognize what you said so it can carry out your commands. But there

are times when DragonDictate makes a mistake. When it does, you

must correct the mistake.

Correcting mistakes is important, because it helps DragonDictate to

recognize your speech. When you correct a mistake that

DragonDictate makes, you improve DragonDictate’s ability to

recognize the word the next time you say it.

The Word History and Choice List

In this lesson, you use the Word History and Choice List to correct

speech-recognition errors.

The Word History is a correction window that includes up to the last

12 words you said. You open the Word History by saying ‘‘Oops’’ or

pressing the minus key on the numeric keypad.

Each word in the Word History has a Choice List. For example, as

shown above, the Word History displays the Choice List for Word 2,

[Bring Up]. The Choice List is a window containing a list of ‘‘best

guesses,’’ representing what DragonDictate thinks you said, starting

with the most likely choice (choice 1).

The Word History.

The Choice List for
Word 2, [Bring Up],
in the Word History.
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You can move to other words in the Word History if you need to

correct them. For example, say ‘‘Word 3’’ to move to the Choice List

for ‘‘[Cancel].’’ Or click the word ‘‘[Cancel]’’ under Word 3.

The Three Question Marks on the Choice List

The tenth choice on the Choice List displays three question marks,

{???}. Say ‘‘Choose 10’’ to reject (erase) a word you don’t want.

Don’t Use the Word History to Edit Commands That DragonDictate

Recognizes Correctly

Keep in mind that you should not use the Word History or Choice

List to change a command you said that DragonDictate recognized

correctly, because you’ll corrupt the integrity of your user files.

For example, you say the commands ‘‘Bring Up’’ and ‘‘Write,’’ which

DragonDictate recognize correctly. On second thought, you want to

bring up WordPerfect. If you use the Word History or Choice List to

change ‘‘Write’’ to ‘‘WordPerfect,’’ DragonDictate recognizes

‘‘WordPerfect’’ every time you say ‘‘Write’’!

In this case, exit Write by saying ‘‘Close Window.’’ Then say 

‘‘Bring Up’’ and ‘‘WordPerfect’’ to start WordPerfect.

�
Attention
Use the Word History
and Choice List to
correct speech-
recognition errors.
Do not use them to
edit commands that
DragonDictate
recognizes correctly.

The Word History.

Say Word 3 to move
to the Choice List for
‘‘Cancel.’’

Chapter 2: Working with DragonDictate
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Correcting Errors with the Word History
You can always use the Word History to correct errors. With the

Word History, you can

n Correct a previous error, up to the last 12 commands you said

n Correct more than one error

n Reject (erase) a word you don’t want

For instance, you want to work with the File menu in WordPerfect.

You say the command ‘‘File.’’ DragonDictate mistakes it as ‘‘Up.’’

You need to use the Word History to correct the mistake.

Or you coughed and DragonDictate recognized a command. You

need to use the Word History to reject the command.

The Three Question Marks {???} and Oops

If DragonDictate can’t recognize what you just said, it displays three

question marks {???} in the last word field of the VoiceBar.

This means you must correct the speech-recognition error.

Note If you cough, and DragonDictate displays three question
marks {???} in the last word field, don’t correct it. But if
you cough and DragonDictate displays a word in the last
word field, reject it.

To correct a speech-recognition error using the Word History, you

say ‘‘Oops’’ or press the minus key (--) on the numeric keypad. Then

you use the Word History to make your corrections.

DragonDictate User’s Guide
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The Choose Command

To correct one error in the Word History, use the Choose command.

For instance, say Choose 8 to choose the eighth choice for the

currently highlighted word in the Word History.

When using the Choose command, you close the Word History and

return to Windows or your Windows application.

Using the Word History to Correct Errors

Correct errors in the Word History, as follows.

1 To open the Word History

@ Say Oops.

� Press the minus key (--) on the numeric keypad.

This brings up the Word History. DragonDictate highlights the last

word it recognized before ‘‘Oops.’’

2 If necessary, move to the word that DragonDictate recognized

incorrectly when you said it

@ For instance, say Word 2 to move to the second word in the

Word History, or Word 3 to move to the third word.

� Click the word under Word 2 or Word 3.

The Word History.

The Choice List for
Word 2, [Up], in the
Word History. Say
Choose 2 to choose
‘‘[File].’’

Chapter 2: Working with DragonDictate
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Note To correct commands you use while in Command Mode,
such as ‘‘[Bring Up],’’ ‘‘[Write],’’ ‘‘[File],’’ ‘‘[Open],’’ you
must start with an open bracket.

3 To correct a word you said that DragonDictate doesn’t recognize

correctly, if the word is in the Choice List

@ Choose it from the Choice List. For example, to choose ‘‘[File],’’ 

say Choose 2. This closes the Word History. Skip to step 4.

� Choose the word from the Choice List by double-clicking it.

This closes the Word History. Skip to step 4.

If the word is not in the Choice List

@ Begin spelling the word by speech, using the alpha-bravo words.

(The alpha-bravo words let DragonDictate better recognize the

letters of the alphabet.) For example, to start spelling ‘‘File,’’ say

Open Bracket, foxtrot, india. When the word shows up in the

Choice List, choose it. For example, say Choose 2. This closes

the Word History. Skip to step 4.

� If the word isn’t in the Choice List, start typing the word. For

example, start typing [File]. Keep typing the word until it shows

up in the Choice List, then choose it. If the word isn’t the first

choice in the list, choose it by pressing the down arrow key, then

press Enter. (�  Or choose it by double-clicking it.) This closes

the Word History. Skip to step 4.

�
Attention
If you have to spell
the word completely,
then you’re adding a
new word to your
active vocabulary 
or group.

The Word History.

The Choice List for
Word 2 in the Word
History. Say 
Choose 6 to choose
‘‘[File].’’
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To reject (erase) a word don’t want

@ Say Choose 10. This closes the Word History. Skip to step 4.

� Double-click the tenth choice. This closes the Word History.

Skip to step 4.

4 @ Repeat the command. For example, say File.

Chapter 2: Working with DragonDictate
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Copying the WordPerfect Program Icon
To control a Windows application by speech, you first must copy the

program icon for that application to the DragonDictate for Windows

program group.

In this section, you copy the WPWin 6.1 program icon to the

DragonDictate for Windows program group.

1 Start Windows or switch to the Windows Program Manager.

2 To display the DragonDictate for Windows program group, if you

don’t see it in the Program Manager

� Click the Window menu. Then click the DragonDictate for

Windows entry.

Note If DragonDictate for Windows is not on the menu, choose
More Windows, then choose DragonDictate for Windows.

3 To display the WPWin 6.1 program group, if you don’t see it in the

Program Manager

� Click the Window menu. Then click the WPWin 6.1 entry.

Note If WPWin 6.1 is not on the menu, choose More Windows,
then choose WPWin 6.1.

Make sure both the
WPWin 6.1 and
DragonDictate for
Windows program
groups appear in the
Program Manager.
Then select the
WPWin 6.1 icon.

DragonDictate User’s Guide
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4 � To select the WPWin 6.1 icon in the WPWin 6.1 program group,

click it once (don’t double-click it).

5 To copy the icon, � press and hold down the Ctrl key, then 

� click and drag the WPWin 6.1 icon to the DragonDictate for

Windows program group.

The WPWin 6.1 icon now appears in the DragonDictate for

Windows program group.

The WPWin 6.1 icon.
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